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➢ Most software programs are downloaded from the internet, 

such as Microsoft Office and Google Chrome. 

➢ To install a program on Windows PC: Download the 

program online, click file in Downloads folder, then follow 

the instructions to complete installation. 

➢ To install an app on Android: Find the app on (Google 

Play Store), then click Install. 

➢ Updates help programs to run more efficiently. 

➢ Many programs install the necessary updates automatically.  
note 

➢ Some major updates require a restart. 

➢ Update in Windows: 

Start button → Settings → Update and Security →Windows Update 

➢ Update in Android: System → System Update 

 

Binary Numbers System 

☑ To solve screen freezes problem: 

• In Windows: Press Ctrl + Alt + Del 

• In Android: Press the power button for 30 seconds and 

restart. 

➢ Computers use binary for efficient data storage. 

➢ Binary numbers are a language understood by computers. 

➢ The binary system uses 1 and 0 (1 is on, O is off). 

 

 

• How Digital Devices WorkLesson 2
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Before starting your project, discuss it in groups: 

The final product The tools needed Assigning roles 

➢ Microsoft Word is an efficient program to use when working 

on projects. 

➢ You can set up a Word document to be edited by numerous 

users in different locations.  
➢ Microsoft Paint can be used to save the images you    create 

and insert them into your document. 

➢ Use emails to send your work to other group members or to 

your teacher. 

 

 

To add To subtract To multiply To divide 

+ - * / 

Add up numbers: 

Home Tab → AutoSum →Enter 

Add titles to a graph/chart 

Toolbar → Chart Design → Add Chart Element 

Choose the color of a graph/chart: 

Toolbar → Chart Design → Format 

Choose the type of a graph/chart: Toolbar 

Toolbar → Chart Design → Change Chart Type 

Choose the layout of a graph/chart: 

Toolbar → Chart Design → Quick Layout 

 

• Determining the Needs for a Digital ProjectLesson 4

• Gathering Data and Presenting InformationLesson 5
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Digital information-handling skills 

Research 

information 

Collect 

information 

Classify 

information 

Process 

information 

➢ To research, first, define a research question. Then, use the 

internet or offline sources. 

➢ You can collect data using Word or Excel (for numeric 

data), and pen and paper. 

➢ Excel graphs are one example of how you can classify and 

provide a visual representation of data. 

➢ Once you have researched, collected, and classified your 

information, you want to process it to get results. 

 

 

➢ In word 

➢ Use one or two colors, or bold a text to emphasize specific 

information. 

➢ Use WordArt to make text have more impact 

➢ In PowerPoint, you can use different background colors. 

➢ Also you can insert photographs, shapes, charts, audio, and 

video 

➢ You can use Movie Maker to make a film from a selection 

of still images. 

 

 

➢ Storyboard: It is a chart that shows a sequence of content 

that forms a plan or outline of your presentation 

Storyboard helps you to: 

• Presenting Information in an Appealing Way.Lesson 6

• Producing an Effective PresentationLesson 7
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 organize and plan your ideas 

 pre-visualize the results of a presentation 

➢ To see an overview of your presentation, go to 

View → Slide Sorter 

The 10-20-30 Rule of Microsoft PowerPoint 

➢ 10: Number of slides up to ten 

➢ 20: The time of presentation no longer than 20 minutes 

➢ 30: The font size no smaller than 30 

 

 

 

Creating a Web Page 

➢ You can create your story through: 

Website-building program 

 Microsoft Word  

➢ In MS Word, to save a file as a web page: 

File → Save As → Web Page 

➢ HTML (Hypertext Markup Language): It is the language 

that will be displayed on a web browser. 

➢ Headings: should have a larger font size than the rest of the 

text. 

➢ Subheadings: break up the information, they have a smaller 

font size than headings. 

➢ Text size: should be suitable and smaller than subheadings. 

➢ Use simple fonts so your message is not hard to read. 

➢ PowerPoint and web pages can include audio and video. 

 

• Web Design PrinciplesLesson 8
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Choose the correct answer from a, b, c or d. 

1- To set up a Word document to be edited by numerous 

users, you need a/an …............ 

a. internet connection   b. printer  

c. interview     d. camera 

2- To send your work to other group members or to your 

teachers, use ………… 

a. Microsoft Word  b. Paint    c. email  d. Excel 

3- When creating new email, you can attach ………… 

a. text file b. image file  c. video file d. all of them 

4- When sending an attachment via email, you should……. 

a. tell the recipients    b. attach virus 

c. send it without message   d. a and b 

5- Microsoft Word program is one of ……… apps. 

a. Microsoft Office 365   b. Microsoft Windows 

c. programming languages  d. gaming platforms 

6- Before opening any email attachment, you should make 

sure that it is …………  

a. virus  b. safe   c. danger  d. none of them 
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7- You can use the ………… sign to add the values of cells 

in Excel. 

a. +   b. −   c. =    d. * 

8- To add up numbers in Excel, select the cells you want to 

add together, then click ………… from the Home Tab. 

a. Chart Design   b. Quick Layout  

c. Format    d. AutoSum 

9- To create a formula, you can write …………  

a. +   b. −   c. =    d. * 

10- To add numbers, you must first ……….. 

a. select the first cell  b. select the last cell 

c. select all cells that contain numbers 

d. none of them 

11- The color of the graph can be chosen from the 

command ………… 

a. Add Chart Element   b. Format 

c. AutoSum    d. Quick Layout 

12- You can use the ………… program to collect numeric 

information. 

a. Word   b. Excel  c. Paint  d. PowerPoint 

13- To add titles or labels of a graph, you can choose 

……….. from Toolbar. 
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a. Add Chart Element  b. Format 

c. Change Chart Type  d. Formula 

 

14- ………… program is used to make slideshows. 

a. MS Word     b. MS Excel 

c. MS PowerPoint   d. Paint 

15- For collecting data, you can use …………  

a. Word     b. pen and paper    

c. Paint     d. a and b 

16- ………… program is used to create tables and graphs. 

a. MS Word     b. MS Excel 

c. MS PowerPoint   d. WhatsApp 

17- ……… tab in Excel contains the AutoSum function. 

a. Layout   b. Design  c. Home  d. Formula 

18- You should download software from ……… sources. 

a. reliable   b. untrusted  

c. unreliable    d. none of them 

19- ………… help(s) programs to run more efficiently. 

a. Updates  b. Removes  c. Shut down d. Restarts 

20- To solve the problem of the screen freezing in 

Windows, you can press ………… 

a. Enter key    b. Alt+Del  

c. Ctrl+Alt+Del   d. none of them 
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21- To solve the problem of screen freezes on Android 

devices, press ………....... 

a. Ctrl+Alt    b. power button for 30 seconds 

c. Del+Alt+Ctrl   d. none of them 

 

22- To turn your device off, hold down the ……… button. 

a. power    b. Esc  c. enter  d. space 

23- Computers use ……… to store data more efficiently.  

a. binary system   b. the internet  

c. box     d. the keyboard 

24- The binary system uses the value(s) ……….. to express 

the binary numbers system. 

a. 0   b. 1   c. a and b  d. none of them 

25- In the computer binary system, the number(0) 

means………… 

a. on  b. off   c. one  d. none of them 

26- Many programs install necessary updates ………… 

a. manually    b. automatically     

c. directions    d. none of them 

27- You can use Ctrl+Alt+Del to solve the problem of 

screen freezes in ............ 

a. Windows PC   b. iPhone  

c. Android   d. a smart watch 
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28- To install a software in Android devices, go to ……… 

a. Google Chrome  b. Google Play Store 

c. Windows   d. none of them  

 

29- Information can be collected using …………  

a. Photoshop  b. Excel  c. Paint d. none of them 

30- An effective presentation is just like a ………… 

a. TV show   b. story  c. movie  d. all of them 

31- You can use PowerPoint to present your ideas in a/an 

………… way. 

a. normal   b. boring  c. appealing   d. bad 

32- In PowerPoint, you can add ………… to a slide. 

a. sounds  b. shapes  c. videos   d. all of them 

33- ………… are considered good ways to share data, 

especially numbers. 

a. Graphs  b. Charts c. Texts   d. a and b 

34- You can use ………… program to make a film from a 

group of still images. 

a. Movie Maker   b. Excel  c. Word     d. Google 

35- You add .............. to enhance text, provided that it is 

related to the displayed data and is not distracting. 

a. graphics  b. audio  c. paragraphs  d. text 
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36- In …………, you can use different slide background 

colors. 

a. web browsers  b. PowerPoint  c. Excel  d. Facebook 

37- You can put important text in ……….. font to make 

key information stand out.  

a. bold  b. save   c. hold   d. file 

38- You can insert ………… to make the text have even 

more impact. 

a. Save  b. WordArt c. PaintArt  d. Art 

39- ........... allow(s) you to plan your ideas and pre-visualize 

the results of a presentation. 

a. WordArt    b. Storyboards  

c. Storytelling   d. b and c 

40- ………… allow(s) you to tell the story in a simple way.  

a. Word     b. Storyboard  

c. Online libraries   d. None of them 

41- To make storyboards to help you produce an effective 

presentation, you can use ………… 

a. PowerPoint b. Excel  c. WordPress d. Facebook 

42- The 10 – 20 - 30 rule is used in the ………… program 

a. Word   b. Excel  c. PowerPoint       d. Paint 
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43- A presentation should not contain more than …….…… 

slides. 

a. 10  b. 20  c. 30    d. 40 

 

44- Storyboards allow you to …………  

a. plan your ideas   b. make videos 

c. collect data    d. make audio 

45- To see an overview of your presentaion, click View, 

then ……………… 

a. Slide Sorter   b. Design Tab  

c. Home Tab    d. Slide Show 

46- The font used in a PowerPoint presentation should be 

no smaller than ………… point size. 

a. 10  b. 20  c. 30    d. 40 

47- It is better not to exceed the duration of presentation 

for ………… minutes. 

a. 10   b. 20  c. 30    d. 40 

48- You can use the ……… Tab in PowerPoint to offer 

alternatives to the normal black-and-white design of 

your presentation. 

a. Design  b. View  c. Insert   d. Home 

49- You can use Microsoft Word to create ………… 
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a. reports  b. web pages  c. graphs  d. a and b 

50- ………… is the language that will be displayed on a 

web browser. 

a. MHLT b. HTML  c. HLMT  d. HMLT 

51- To save your document as a web page, select Save As 

from ………… menu. 

a. View   b. File   c. Design  d. Home 

52- A web page's ……….. breaks up the information and 

allows your audience to see what a particular section of 

your story is about. 

a. heading b. subheading  c. main text  d. link 

53- Subheadings have a font size ……… the size of the 

main headings. 

a. bigger than   b. smaller than  

c. the same as   d. none of them 

============================================ 

Put (✔) or (✕): 

1- It's important to plan your work before starting. ( ) 

2- It is not available to edit a Word document online.( ) 

3- One of the tools you may need for a group project is 

email.          ( ) 

4- You can't attach a document to your email.  ( ) 
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5- Assigning roles is based on the interests of each group 

member.          (  ) 

6- Be sure to answer any questions the group members 

may have.          ( ) 

7- Before starting work on any project, a list of the tools 

needed for each part of the project must be determined. 

( ) 

8- You can use email to send your homework to your 

teacher.         ( ) 

9- All software updates require a restart.    ( ) 

10- "Screen freezes" is one of the common problems 

when using a PC.        ( ) 

11- The binary system uses the values 1 and 2. ( ) 

12- Users can face various problems when using 

computers.         ( ) 

13- You can use "Task Manager" to shut down non-

responding programs.      ( ) 

14- To solve the problem of the screen stopping 

responding on Android, devices, press the power button 

for 30 seconds.        ( ) 

15- Binary numbers is a language that the computer 

understands.        ( ) 
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16- We should download software from unreliable 

sources.         ( ) 

17- Computers use binary system to store data more 

efficiently.         ( ) 

18- To automatically add up numbers in cells, select them 

and choose AutoSum.      ( ) 

19- Graphs and charts are good tools to share data.( ) 

20- To add the values of the cells, use the "+" sign. ( ) 

21- Processing information comes after data collection.(   ) 

22- You can use digital tools to collect data.  ( ) 

23- You could use PowerPoint to create presentations.( ) 

24- You can't use Excel in gathering data and 

information.        ( ) 

25- Information can be collected using Photoshop. ( ) 

26- AutoSum is used to divide cell values automatically in 

Excel.          ( ) 

27- We use AutoSum to automatically subtract numbers 

in Excel.          ( ) 

28- You can use a pen and paper to collect data.  ( ) 

29- You can't add shapes to slides in PowerPoint. ( ) 

30- You can color important text to emphasize specific 

information.         ( ) 
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31- You cannot insert an image into a Word document.(  ) 

32- You can insert audio to enhance the text in your 

slideshow.          ( ) 

 

33- Photographs should reflect the topic of your message.  

( ) 

34- You can add videos in your presentation.  ( ) 

35- WordArt is an amazing feature in Paint.  ( ) 

36- Graphs and charts are good tools to share data, 

especially numbers.       ( ) 

37- We use Movie Maker to make a film from a selection 

of still images.        ( ) 

38- Respect others' intellectual property when using their 

material.          ( ) 

39- Excel is used to create presentations.   ( ) 

40- A storyboard helps you organize your ideas in 

sequence.          ( ) 

41- The 10 – 20 - 30 rule is used in Microsoft PowerPoint. 

( ) 

42- Be sure the font size is easy to read in your 

presentation.        ( ) 
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43- A PowerPoint presentation should present too much 

information.         (  ) 

44- HLTM is the language that will be displayed on a web 

browser.         (  ) 

45- Use simple fonts so your message is hard to read. (     ) 

46- Web pages can't include audio and video.  (  ) 

47- You can save a Word file as a web page.  (  ) 

48- You can save a document as a web page from the Edit 

menu.          (  ) 

49- Web pages just include large images. 

============================================ 

Complete the missing parts using the words between the 

brackets: 

(30 seconds - binary numbers - Google Play Store - power - 

Ctrl+Alt+Del) 

1- ……… used to solve the problem of screen freezes in 

Windows. 

2- To turn your cell phone off, press the ................ button 

for ………… 

3- The language understood by computer devices is 

called…………… 

4- …………… used to install software to Android device. 
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----------------------------------------------------------------------- 

 

 

 

(Add Chart Element - "=" – Processing - MS PowerPoint - 

Excel) 

1- ………… is the program used to make presentations. 

2- ………… is used for numeric data drawn in the form of 

a graph. 

3- ………… data is crucial to get results and share them 

with others. 

4- To create an equation in MS Excel, you should use the 

………… sign. 

5- To add titles to a graph, ………… from Toolbar/Chart 

Design. 

-------------------------------------------------------------------- 

(WordArt - audio clips - Excel - PowerPoint - Movie 

Maker) 

1- ………… program is used to make slideshows. 

2- ………… program is used to create a graph. 

3- A program used to make a film from a selection of still 

images is ………… 
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4- You can add ………… to the presentation. 

5- You can also insert ………… to make the text have even 

more impact. 

 

Choose from column (A) what suits it in column (B): 

Column (A) Column (B) 

1- Storyboard 
a. is a digital tool used to make a 

presentation. 

2- View/Slide 

Sorter 

b. shouldn't be smaller than 30-point 

size in a presentation. 

3- Font size 
c. allows you to see an overview of your 

presentation. 

4- Design tab 

d. offers alternatives to the normal 

black-and-white design of your 

presentation. 

5- Microsoft 

PowerPoint 

e. helps you organize your ideas in a 

presentation. 

(1) …….… (2) …….…(3) ………..(4) ……..…(5) …….… 
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Put (✔) mark in front of the correct statement and (✕) 

mark in front of the wrong statement: 

1. Paint program is used when working on various 

projects.         ( ) 

2. Microsoft Word allows multiple users around the world 

to edit the same document online.    ( ) 

3. Paint program is used to edit and save images. ( ) 

4. Microsoft Word is one of the useful programs for the 

implementation of a project.     ( ) 

5. Before starting a project, it is not necessary for group 

members to understand their roles in the project.( ) 

6. Email helps you send your work to your teacher and 

group colleagues.       ( ) 

7. The Internet enables you to download programs and 

applications from official application stores.  ( ) 

8. Computers use binary systems to store data. ( ) 

9. When you download a file for a specific program, this 

file appears to you in the Download folder.  ( ) 

10. Computers do not understood Numbers in binary 

systems.         ( ) 
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11. The software on the computers must be constantly 

updated to work efficiently.     ( ) 

12. The binary system uses 0,1 to express numbers on 

computers.         ( ) 

13. Using Excel, you can add up a group of cells. ( ) 

14. Graphs and charts are a good way to share data.( ) 

15. Using Excel, you can perform a calculation on a group 

of cells.          ( ) 

16. Power Point presentation program allows adding 

effects to slides.        ( ) 

17. The Paint program helps you classify and process 

information.         ( ) 

18. It is better to add audio content to enhance the text 

and image on the presentation.    ( ) 

19. The presentation should contain a huge amount of 

information.         ( )  

20. Hypertext markup language (HTML) helps you to 

design a web page.       ( ) 

21. The font size within the presentation should be 

appropriate and easy to read.     ( ) 

22. HTML is an abbreviation for Hyper Text Markup 

Language.         ( ) 
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--------------------------------------------------------------------------- 

Choose the correct answer from a, b, c or d. 

1. To edit a document on a Word file, you must ............ 

A. Paste document.   B. Select document.  

C. Copy document.   D. Delete document. 

2- To solve the problem of the screen freezing, click ……… 

A. F5+Enter. 

B. Del+F1. 

C. Del+Alt+F7. 

D. Crtl+Alt+Del. 

3- Use ………… search engine on search. 

A. Google   B. Home 

C. Paint.    D. Power Point. 

4- ………… is a chart that shows a specific content 

sequence in the form of a chart. 

A. Storyboard. 

B. Playlists. 

C. Playback Tools. 

D. Menu Bar. 
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Choose the correct answer from a, b, c or d. 

1- To set up a Word document to be edited by numerous users, you 

need a/an …............ 

a. internet connection   b. printer  

c. interview     d. camera 

2- To send your work to other group members or to your teachers, 

use ………… 

a. Microsoft Word  b. Paint    c. email  d. Excel 

3- When creating new email, you can attach ………… 

a. text file b. image file  c. video file d. all of them 

4- When sending an attachment via email, you should……. 

a. tell the recipients            b. attach virus 

c. send it without message   d. a and b 

5- Microsoft Word program is one of ……… apps. 

a. Microsoft Office 365   b. Microsoft Windows 

c. programming languages  d. gaming platforms 

6- Before opening any email attachment, you should make sure 

that it is …………  

a. virus  b. safe   c. danger  d. none of them 

7- You can use the ………… sign to add the values of cells in Excel. 

a. +   b. −   c. =    d. * 

8- To add up numbers in Excel, select the cells you want to add 

together, then click ………… from the Home Tab. 

a. Chart Design   b. Quick Layout  

c. Format    d. AutoSum 
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9- To create a formula, you can write …………  

a. +   b. −   c. =    d. * 

10- To add numbers, you must first ……….. 

a. select the first cell                             b. select the last cell 

c. select all cells that contain numbers        d. none of them 

11- The color of the graph can be chosen from the command 

………… 

a. Add Chart Element   b. Format 

c. AutoSum    d. Quick Layout 

12- You can use the ………… program to collect numeric 

information. 

a. Word   b. Excel  c. Paint  d. PowerPoint 

13- To add titles or labels of a graph, you can choose ……….. from 

Toolbar. 

a. Add Chart Element  b. Format 

c. Change Chart Type  d. Formula 

 

14- ………… program is used to make slideshows. 

a. MS Word     b. MS Excel 

c. MS PowerPoint   d. Paint 

15- For collecting data, you can use …………  

a. Word     b. pen and paper    

c. Paint     d. a and b 
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16- ………… program is used to create tables and graphs. 

a. MS Word     b. MS Excel 

c. MS PowerPoint   d. WhatsApp 

17- ……… tab in Excel contains the AutoSum function. 

a. Layout   b. Design  c. Home  d. Formula 

18- You should download software from ……… sources. 

a. reliable   b. untrusted  

c. unreliable    d. none of them 

19- ………… help(s) programs to run more efficiently. 

a. Updates  b. Removes  c. Shut down d. Restarts 

20- To solve the problem of the screen freezing in Windows, you can 

press ………… 

a. Enter key    b. Alt+Del  

c. Ctrl+Alt+Del   d. none of them 

21- To solve the problem of screen freezes on Android devices, press 

………....... 

a. Ctrl+Alt    b. power button for 30 seconds 

c. Del+Alt+Ctrl   d. none of them 

 

22- To turn your device off, hold down the ……… button. 

a. power    b. Esc  c. enter  d. space 

23- Computers use ……… to store data more efficiently.  

a. binary system   b. the internet  

c. box     d. the keyboard 

24- The binary system uses the value(s) ……….. to express the 

binary numbers system. 

a. 0   b. 1   c. a and b  d. none of them 

 



 

5 
 

25- In the computer binary system, the number(0) means………… 

a. on  b. off   c. one  d. none of them 

26- Many programs install necessary updates ………… 

a. manually    b. automatically     

c. directions    d. none of them 

27- You can use Ctrl+Alt+Del to solve the problem of screen freezes 

in ............ 

a. Windows PC   b. iPhone  

c. Android   d. a smart watch 

28- To install a software in Android devices, go to ……… 

a. Google Chrome  b. Google Play Store 

c. Windows   d. none of them  

29- Information can be collected using …………  

a. Photoshop  b. Excel  c. Paint d. none of them 

30- An effective presentation is just like a ………… 

a. TV show   b. story  c. movie  d. all of them 

31- You can use PowerPoint to present your ideas in a/an ………… 

way. 

a. normal           b. boring             c. appealing  d. bad 

32- In PowerPoint, you can add ………… to a slide. 

a. sounds          b. shapes             c. videos   d. all of them 

33- ………… are considered good ways to share data, especially 

numbers. 

a. Graphs                b. Charts            c. Texts   d. a and b 
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34- You can use ………… program to make a film from a group of 

still images. 

a. Movie Maker   b. Excel  c. Word     d. Google 

35- You add .............. to enhance text, provided that it is related to 

the displayed data and is not distracting. 

a. graphics       b. audio  c. paragraphs d. text 

36- In …………, you can use different slide background colors. 

a. web browsers  b. PowerPoint  c. Excel  d. Facebook 

37- You can put important text in ……….. font to make key 

information stand out.  

a. bold  b. save   c. hold   d. file 

38- You can insert ………… to make the text have even more 

impact. 

a. Save  b. WordArt c. PaintArt  d. Art 

39- ........... allow(s) you to plan your ideas and pre-visualize the 

results of a presentation. 

a. WordArt    b. Storyboards  

c. Storytelling            d. b and c 

40- ………… allow(s) you to tell the story in a simple way.  

a. Word     b. Storyboard  

c. Online libraries   d. None of them 

41- To make storyboards to help you produce an effective 

presentation, you can use ………… 

a. PowerPoint  b. Excel  c. WordPress d. Facebook 
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42- The 10 – 20 - 30 rule is used in the ………… program 

a. Word   b. Excel  c. PowerPoint       d. Paint 

43- A presentation should not contain more than …….…… slides. 

a. 10                    b. 20             c. 30    d. 40 

44- Storyboards allow you to …………  

a. plan your ideas   b. make videos 

c. collect data    d. make audio 

45- To see an overview of your presentaion, click View, then 

……………… 

a. Slide Sorter            b. Design Tab  

c. Home Tab    d. Slide Show 

46- The font used in a PowerPoint presentation should be no smaller 

than ………… point size. 

a. 10       b. 20  c. 30    d. 40 

47- It is better not to exceed the duration of presentation for 

………… minutes. 

a. 10   b. 20  c. 30    d. 40 

48- You can use the ……… Tab in PowerPoint to offer alternatives 

to the normal black-and-white design of your presentation. 

a. Design  b. View c. Insert   d. Home 

49- You can use Microsoft Word to create ………… 

a. reports     b. web pages     c. graphs  d. a and b 

50- ………… is the language that will be displayed on a web 

browser. 

a. MHLT         b. HTML  c. HLMT  d. HMLT 
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51- To save your document as a web page, select Save As from 

………… menu. 

a. View   b. File  c. Design     d. Home 

52- A web page's ……….. breaks up the information and allows 

your audience to see what a particular section of your story is 

about. 

a. heading   b. subheading  c. main text  d. link 

53- Subheadings have a font size ……… the size of the main 

headings. 

a. bigger than   b. smaller than  

c. the same as   d. none of them 

============================================ 

Put (✔) or (✕): 

1- It's important to plan your work before starting. (✔ ) 

2- It is not available to edit a Word document online.(✕ ) 

3- One of the tools you may need for a group project is email. 

          (✔) 

4- You can't attach a document to your email.  (✕ ) 

5- Assigning roles is based on the interests of each group member. 

          (✔ ) 

6- Be sure to answer any questions the group members may have. 

          (✔ ) 

7- Before starting work on any project, a list of the tools needed for 

each part of the project must be determined. (✔ ) 
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8- You can use email to send your homework to your teacher. 

          (✔ ) 

9- All software updates require a restart.    (✕ ) 

10- "Screen freezes" is one of the common problems when using 

a PC.          (✔ ) 

11- The binary system uses the values 1 and 2. (✕ ) 

12- Users can face various problems when using computers. 

          (✔ ) 

13- You can use "Task Manager" to shut down non-responding 

programs.        (✔ ) 

14- To solve the problem of the screen stopping responding on 

Android, devices, press the power button for 30 seconds. 

          (✔ ) 

15- Binary numbers is a language that the computer understands.

          (✔ ) 

16- We should download software from unreliable sources. 

          (✕ ) 

17- Computers use binary system to store data more efficiently.

          (✔ ) 

18- To automatically add up numbers in cells, select them and 

choose AutoSum.       (✔ ) 

19- Graphs and charts are good tools to share data.(✔ ) 

20- To add the values of the cells, use the "+" sign. (✔ ) 
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21- Processing information comes after data collection.(✔   ) 

22- You can use digital tools to collect data.  (✔ ) 

23- You could use PowerPoint to create presentations.( ✔  ) 

24- You can't use Excel in gathering data and information. 

          (✕ ) 

25- Information can be collected using Photoshop. (✕ ) 

26- AutoSum is used to divide cell values automatically in Excel.

          (✕ ) 

27- We use AutoSum to automatically subtract numbers in Excel. 

          (✕ ) 

28- You can use a pen and paper to collect data.  (✔ ) 

29- You can't add shapes to slides in PowerPoint. (✕ ) 

30- You can color important text to emphasize specific 

information.        (✔ ) 

31- You cannot insert an image into a Word document.( ✕  ) 

32- You can insert audio to enhance the text in your slideshow. 

          (✔ ) 

33- Photographs should reflect the topic of your message. (✔ ) 

34- You can add videos in your presentation.  (✔ ) 

35- WordArt is an amazing feature in Paint.  (✕ ) 

36- Graphs and charts are good tools to share data, especially 

numbers.        (✔ ) 



 

11 
 

37- We use Movie Maker to make a film from a selection of still 

images.        (✔ ) 

38- Respect others' intellectual property when using their 

material.          (✔ ) 

39- Excel is used to create presentations.    (✕ ) 

40- A storyboard helps you organize your ideas in sequence.  

           (✔ ) 

41- The 10 – 20 - 30 rule is used in Microsoft PowerPoint. 

(✔ ) 

42- Be sure the font size is easy to read in your presentation. 

           (✔ ) 

43- A PowerPoint presentation should present too much 

information.         ( ✕ ) 

44- HLTM is the language that will be displayed on a web 

browser.         ( ✔ ) 

45- Use simple fonts so your message is hard to read. (✕    ) 

46- Web pages can't include audio and video.  ( ✕ ) 

47- You can save a Word file as a web page.  ( ✔ ) 

48- Web pages just include large images.     ( ✕ ) 
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============================================ 

Complete the missing parts using the words between the brackets: 

(30 seconds - binary numbers - Google Play Store - power - 

Ctrl+Alt+Del) 

1- Ctrl+Alt+Del used to solve the problem of screen freezes in 

Windows. 

2- To turn your cell phone off, press the power button for 30 

seconds 

3- The language understood by computer devices is called binary 

numbers 

4- Google Play Store used to install software to Android device. 

----------------------------------------------------------------------- 

(Add Chart Element - "=" – Processing - MS PowerPoint - Excel) 

1- MS PowerPoint is the program used to make presentations. 

2- Excel is used for numeric data drawn in the form of a graph. 

3- Processing data is crucial to get results and share them with 

others. 

4- To create an equation in MS Excel, you should use the "="sign. 

5- To add titles to a graph, Add Chart Element from 

Toolbar/Chart Design. 

-------------------------------------------------------------------- 

(WordArt - audio clips - Excel - PowerPoint - Movie Maker) 

1- PowerPoint program is used to make slideshows. 
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2- Excel program is used to create a graph. 

3- A program used to make a film from a selection of still images 

is Movie Maker 

4- You can add audio clips to the presentation. 

5- You can also insert WordArt to make the text have even more 

impact. 

 

Choose from column (A) what suits it in column (B): 

Column (A) Column (B) 

1- Storyboard 
a. is a digital tool used to make a 

presentation. 

2- View/Slide 

Sorter 

b. shouldn't be smaller than 30-point size in 

a presentation. 

3- Font size 
c. allows you to see an overview of your 

presentation. 

4- Design tab 
d. offers alternatives to the normal black-

and-white design of your presentation. 

5- Microsoft 

PowerPoint 

e. helps you organize your ideas in a 

presentation. 

 

(1) e (2) c (3) b (4) d (5) a  
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Story board 
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Put (✔) mark in front of the correct statement and (✕) mark in 

front of the wrong statement: 

1. Paint program is used when working on various projects. 

         (✕) 

2. Microsoft Word allows multiple users around the world to edit 

the same document online.    (✔) 

3. Paint program is used to edit and save images. (✔) 

4. Microsoft Word is one of the useful programs for the 

implementation of a project.     (✔) 

5. Before starting a project, it is not necessary for group members 

to understand their roles in the project.  (✕) 

6. Email helps you send your work to your teacher and group 

colleagues.        (✔) 

7. The Internet enables you to download programs and 

applications from official application stores.  (✔) 

8. Computers use binary systems to store data.  (✔) 

9. When you download a file for a specific program, this file 

appears to you in the Download folder.   (✔) 

10. Computers do not understood Numbers in binary systems.

          (✕) 
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11. The software on the computers must be constantly updated to 

work efficiently.       (✔) 

12. The binary system uses 0,1 to express numbers on computers.

          (✔) 

13. Using Excel, you can add up a group of cells. (✔) 

14. Graphs and charts are a good way to share data.(✔) 

15. Using Excel, you can perform a calculation on a group of cells. 

          (✔) 

16. Power Point presentation program allows adding effects to 

slides.          (✔) 

17. The Paint program helps you classify and process 

information.        (✕) 

18. It is better to add audio content to enhance the text and image 

on the presentation.      (✔)  

19. The presentation should contain a huge amount of 

information.        (✕ )  

20. Hypertext markup language (HTML) helps you to design a 

web page.        (✔ ) 

21. The font size within the presentation should be appropriate 

and easy to read.       (✕ ) 

22. HTML is an abbreviation for Hyper Text Markup Language.

          (✔ ) 

--------------------------------------------------------------------------- 
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Choose the correct answer from a, b, c or d. 

1. To edit a document on a Word file, you must ............ 

A. Paste document.   B. Select document.  

C. Copy document.   D. Delete document. 

2- To solve the problem of the screen freezing, click ……… 

A. F5+Enter. 

B. Del+F1. 

C. Del+Alt+F7. 

D. Crtl+Alt+Del. 

3- Use ………… search engine on search. 

A. Google   B. Home 

C. Paint.    D. Power Point. 

4- ………… is a chart that shows a specific content sequence in the 

form of a chart. 

A. Storyboard. 

B. Playlists. 

C. Playback Tools. 

D. Menu Bar. 




